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Hvad går i hjem med?

Litteratursøgning er essentielt! 
Jeg vil præsenterer forskellige søgeteknikker 

og metoder, og i får lov til at prøve selv i 

databaserne.

Referencehåndtering er nemt!
Jeg viser jer hvordan i bruger EndNote, til 

overskueligt og nemt holde styr på jeres 

litteratur og referere korrekt i jeres opgaver.



Litteratursøgning



Hvorfor søge litteratur?

For at blive klogere på dit emne
Hvis du skal skrive en opgave, er det er også vigtigt inden du har fundet din problemformulering

For at underbygge argumentation
Hvis du skal skrive en opgave, er det vigtigt at dine påstande er underbygget af anden litteratur

For at finde huller i den eksisterende forskning
Og derved minimere risikoen for at reproducere allerede eksisterende forskning.



Søgeprocessen





Omsæt dit informationsbehov til emneord

• Centrale ord og begreber i problemformulering og 

emnebeskrivelse

• Læs dig ind på fagterminologien i litteratur, du allerede kender

• Kig i abstract, bagsidetekst og indholdsfortegnelse

• Slå titlen op på library.au.dk - bliv inspireret af emneord / 

keywords / subject terms

• Opslagsværker fra Fagsiden

• Tænk i bredere og snævrere begreber, synonymer, sprog og 

stavemåder

• Lav hurtigsøgninger eller brug AI

• Reflekter over din egen position og bias

https://library.au.dk/fagsider/molekylaerbiologioggenetik/


Eksempel

PCR

PCR

polymerase chain reaction

CFTR-genet

CFTR-gene

CFTR

”Hvordan bruges PCR til at påvise en mutation i CFTR-genet”

Mutation

Mutation

Mutations



• Brug 5 minutter på at opdele din problemformulering eller 

emnebeskrivelse i hovedemner og begynd at lave emneord. 

• Målet er at finde mange og gode søgeord, så tænk i bredere og 

smallere begreber, fagtermer, synonymer. Oversæt også til 

engelsk. Find eventuelt inspiration med hurtigsøgninger.

• Brug 5 minutter på, at præsentere og drøfte med jeres sidemakker 

• Er der noget der kan præciseres eller er uklart? 

Øvelse
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Tre søgestrategier

Kædesøgning i referencer – søg bagudrettet

Citationssøgning i databasers citationsindeks – søg fremadrettet 

Emneordssøgning i databaser – kom i gang med at søge og søg 

systematisk



Kædesøgning
Søg bagud i tid via litteraturlisten i bøger og artikler, du allerede 

kender eller finder i din søgning

Tjek om forfatteren har udgivet andet relevant litteratur, fx i 

forskningsdatabaser som PURE, eller citationsdatabaser som Web 

of Science eller Scopus



Citationssøgning
Søg fremad i tid med afsæt i artikel du kender eller som du finder i 

din søgning

Du kan finde artiklen i en citationsdatabaser som Web of Science 

eller Scopus, og se hvilke artikler der efterfølgende har citeret din 

artikel



Emneordssøgning
Emneordssøgning handler om at finde og sammensætte de mest 

relevante søgeord som giver:

• Nok litteratur til at kunne besvare problemformuleringen

• Minimalt niveau af støj – dvs. materialer uden relevans for din 

problemstilling

Prøv dig frem med forskellige kombinationer af søgeord, indtil du 

rammer en god balance



Søgeteknik 

Frasesøgning

• Brug ”citationstegn”, når du søger på ord, der skal stå sammen 

• F.eks. Digital communities vs. ”Digital communities”

• Vær dog opmærksom på at det ikke altid er gavnligt 

Trunkering

• * står i stedet for alle mulige endelser af et ord

• Trust* (søger på trust, trusts, trusting, trustworthy etc.)

• Vær dog opmærksom på at det ikke altid er gavnligt og det 

virker ikke i alle databaser



AND

ORNOT

Søgeteknik 

Booleske operatorer 

• Du kan bruge til at kombinere dine søgeord: AND, OR, NOT.

• Gør din søgning præcis  - og gør dig i stand til at indskrænke 

eller udvide dine søgninger

• OBS: Brug altid store bogstaver



AND: indsnævrer din søgning: resultater skal inkludere alle søgeord

OR: udvider din søgning: resultater kan inkludere et eller flere af 

søgeordene. Bruges f. eks. til at inkludere synonymer

NOT: ord du vil udelade. Bruges sjældent, da du risikerer at 

ekskludere relevante resultater

Emneord A Emneord B



Eksempel

”Hvordan bruges PCR til at påvise en mutation i CFTR-genet”

Søgestreng:

(PCR OR "polymerase chain reaction”) AND (Mutation*) AND (CFTR OR CFTR-gene) 

Parenteser sættes rundt 

om emneord der er 

sammensat med OR



Databaser

Biblioteksdatabaser: tværfaglige og gode til bøger 

• Library.au.dk

• Bibliotek.dk

Videnskabelige databaser: fagspecifikke

• Embase

• PubMed

Citationsdatabaser: tværfaglige men store

• Web of Science

• Scopus

Nyhedsdatabaser: medieovervågning

• Infomedia

Få adgang til 

databaserne (og 

artiklerne) via 

library.au.dk eller på 

fagsiden

https://library.au.dk/
https://library.au.dk/
https://bibliotek.dk/
https://bibliotek.dk/
https://soeg.kb.dk/permalink/45KBDK_KGL/1pioq0f/alma99122994120105763
https://soeg.kb.dk/permalink/45KBDK_KGL/1pioq0f/alma99122994120105763
https://soeg.kb.dk/permalink/45KBDK_KGL/1pioq0f/alma99122975029205763
https://soeg.kb.dk/permalink/45KBDK_KGL/1pioq0f/alma99122975029205763
https://www-webofscience-com.ez.statsbiblioteket.dk/wos/woscc/basic-search
https://www-webofscience-com.ez.statsbiblioteket.dk/wos/woscc/basic-search
https://www-scopus-com.ez.statsbiblioteket.dk/search/form.uri?display=basic#basic
https://www-scopus-com.ez.statsbiblioteket.dk/search/form.uri?display=basic#basic
https://infomedia.dk/
https://infomedia.dk/
library.au.dk
https://library.au.dk/fagsider/molekylaerbiologioggenetik/


Eksempel i database

Fagsiden for Molekylærbiologi og Genetik

(PCR OR "polymerase chain reaction”) AND

(Mutation*) AND (CFTR OR CFTR-gene) 
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https://library.au.dk/fagsider/molekylaerbiologioggenetik/


Opgave

Sammensæt dine emneord i en søgestreng i en selvvalgt database (husk at du kan finde databaserne på 

fagsiden)

―Juster på din søgning undervejs og se om du kan finde en relevant artikel

―Drøft resultatet med din sidemakker

―Bliv ved resultaterne, vi skal bruge dem senere
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Hvem har skrevet teksten?

• Hvad er forfatterens baggrund? 

(uddannelse, forskningsområde, mm.)

• Undersøg forfatterens motivationen for 

at skrive teksten. Er teksten f eks. en del 

af en længere diskussion?

Hvor kommer teksten fra?

• Tænk over forlaget eller udgiverens 

bagvedliggende motivation. 

• Hvor har du teksten fra?

• Hvis du arbejder med tidsskriftartikler, 

er det værd at undersøge, 

om tidsskriftet anvender 

fagfællebedømmelse/peer-review

Hvad står der i teksten?

• Hvordan er sproget og strukturen i teksten? 

• Hvilken type af tekst er det?

• Er det en primærkilde eller en 

sekundærkilde?

• Er der referencer i teksten? Er der påstande 

i teksten uden referencer?

• Er der andre kilder, der modsiger 

pointerne?

Hvad skal du bruge teksten til?

• Overvej om en kilde hører til i dit 

projekts kontekst. Hvornår er den 

skrevet? Er informationen stadigvæk 

aktuel? Bidrager kilden til diskussion? 

• Husk at du kan inddrage både 

videnskabelige artikler og 

nyhedsartikler i din opgave. 



Hjælp til søgning

Studypedia:

https://studypedia.au.dk/informationssoegning

Library.au.dk:

https://library.au.dk/studerende/informationssoegning

Kontaktbibliotekarer:

https://library.au.dk/fagsider/molekylaerbiologioggenetik/

Eller kig forbi vejledningen på AU Library Katrinebjerg!

https://studypedia.au.dk/informationssoegning
https://library.au.dk/studerende/informationssoegning
https://library.au.dk/fagsider/molekylaerbiologioggenetik/


AI og 
Litteratursøgning



Opmærksomhedspunkt:

Baseret på sandsynlighed

• Sprogmodeller gætter eller opfinder noget der lyder rigtigt, på baggrund af 

sandsynlighedsberegninger

• F. eks.: Wenger, E (1991). Communities of Practice: A guide to Managing Knowledge, Springer



Opmærksomhedspunkt:

kontrol af information

• Sprogmodeller kan være trænet til at undvige vise emner eller typer af information

• Det vil ikke altid fremgå hvis outputtet er påvirket af bagvedliggende begrænsninger 



Opmærksomhedspunkt:

Afhængig af kontekst

• Domæneviden er rigtig vigtigt!

• Sprogmodeller vil lave fejlagtige sammenkoblinger, 

især ved manglende kontekst.

• Nogle gang vil fejl være nemme at spotte, men ikke 

altid.

• Sprogmodeller kan få det meste til at lyde 

troværdigt, selvom det ikke har hold i virkeligheden 

• Det er derfor vigtigt at validere faktuelle svar fra en 

sprogmodel! 



Opmærksomhedspunkt:

Hallucinationer

• Når en sprogmodel som ChatGPT eller Copilot kommer med usande 

informationer, så siger man at den hallucinere. 

• Hallucinationerne opstår, fordi sprogmodellen ikke forstår verden, men 

efterligner mønstre fra deres træning – de skaber svar ud fra sandsynlighed 

og ikke fakta. 

• Nogle gange føre det til fejlagtige sammenkoblinger, der lyder troværdigt, 

men ikke har hold i virkeligheden 

• Det er derfor vigtigt at validere faktuelle svar fra en sprogmodel! 

Image found on Reddit



Opmærksomhedspunkt:

Hallucinationer



Opmærksomhedspunkt:

Spytslikker feedback 

• En sprogmodel vil tilpasser sig dine holdninger og bekræfter dig – selvom 

du tager fejl! 

• Hvis du for eksempel giver udtryk for en bestemt mening eller et faktuelt 

forkert udsagn vil modellen støtte i stedet for et udfordre. 

• Modellens mål er at være hjælpsom og imødekommende 

• Derfor kan du blive bekræftet i noget usandt, eller få en endnu smallere 

forståelse af et emne. 



Opmærksomhedspunkt:

Bias

• Sprogmodeller er trænet på enorme mængder af data og tekst fra internettet der indeholder 

stereotyper, fordomme og skævvridninger. 

• De mønstre snige sig ind i outputtet, uden at du nødvendigvis opdager det. 

• Bias kan f.eks. være i kønsroller, kulturelle antagelser eller politiske vinkler. 

• Sprogmodeller gentager og forstærker mønstre fra sin træningsdata. 

• Derfor skal du være opmærksom på, om der gemmer sig skjulte fordomme eller skævvridninger i 

de svar du får 

ChatGPT

Gemini

Copilot

Gemini

ChatGPT

Copilot



Opmærksomhedspunkt:

GDPR og ophavsret

GDPR

― Generativ AI skelner ikke mellem offentlige og private oplysninger – den 

behandler alt, hvad den modtager. 

― Vi ved ikke nødvendigvis, hvem der får adgang.

― Det er dit ansvar at sikre, at input ikke kompromitterer din egen eller 

andres privatliv

Ophavsret

― Du må ikke indtaste ophavsretligt beskyttet tekst, billeder, musik osv. i 

systemet uden tilladelse.

― Det er dit ansvar at sikre, at både input og output ikke krænker andres 

rettigheder



AI og litteratursøgning

Kreativitet Nøjagtighed



AI ressourcer til rådighed

Embase AI

― Adgang via AU Network 

― Integreret AI søgninng

Scite.ai

― Adgang via AU Network 

― Inkluderer en AI-assistent, der kan hjælpe med at besvare spørgsmål baseret på 

underliggende dokumentation

KB Research Assistant

― Adgang via AU Library.au.dk eller soeg.kb.dk – du skal være logget ind

― Data fra Central Discovery Index – bibliotekets online samling + mere

― Genererer et overblik ud fra de 5 øverste søgeresultater

Copilot

― Alle studerende på AU har via deres AU-login adgang til den databeskyttede 

basisversion af det generative AI-værktøj (GAI) Microsoft Copilot. 

― At værktøjet er databeskyttet betyder, at det ikke gemmer eller bliver trænet på de 

data, der indtastes. Vær dog opmærksom på, at du ikke må bruge GAI-værktøjer 

som Microsoft Copilot til fortrolige og følsomme data

https://soeg.kb.dk/permalink/45KBDK_KGL/1pioq0f/alma99122994120105763
https://soeg.kb.dk/permalink/45KBDK_KGL/1pioq0f/alma99122994120105763
https://soeg.kb.dk/discovery/researchAssistant?vid=45KBDK_KGL:KGL
https://studerende.au.dk/it-support/microsoft-365


Referencehåndtering



Referencehåndtering
og citationspraksis
Hvorfor referere?

― Dokumentation

― Argumentation

― Troværdighed

― Undgå plagiat

Referencestil

― Korrekte referencer afhænger af den referencestil du 

bruger

― Vær konsistent i dine referencer

― Brug af referenceværktøj er en kæmpe hjælp

Læs mere:

― https://library.au.dk/studerende/referencehaandtering

― Purdue Owl's APA Formatting and Style Guide

https://library.au.dk/studerende/referencehaandtering
https://library.au.dk/studerende/referencehaandtering
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatting_and_style_guide/index.html
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatting_and_style_guide/index.html
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatting_and_style_guide/index.html
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatting_and_style_guide/index.html


EndNote

EndNote er et referencehåndteringsværktøj, der kan:

― Samle litteratur/referencer

― Organiserer samlingen af litteratur

― Generere citationer og litteraturlister

― Synkroniserer samling på tværs af enheder og grupper

Jeg gennemgår:

Jeg gennemgår:

― Opret et bibliotek

― Synkronisering og konto

― Grænsefladen

― Import af referencer

― Organisering af referencer

― Arbejde med PDF’er

― Cite While You Write i Word

― Deling og grupper



Opret et bibliotek

1. Når du åbner EndNote første gang på PC, vil du 

blive bedt om at vælge en placering til dit bibliotek. 

På Mac skal du selv vælge File → New, og herefter 

vælge din fil placering. 

2. Gem det et stabilt sted på computeren (ikke i skyen! 

OneDrive/SharePoint/Dropbox mm. Det vil skabe fejl 

i synkroniseringen. Der laves back up ved at oprete

en online konto, og sætte den til at synkroniserer).

3. Du skal ikke lave et nyt bibliotek for hver samling du 

gerne vil have, men kun have et bibliotek. Inde i 

dette bibliotek kan du have mange forskellige 

samlinger.



Synkronisering og konto
1. Klik på Edit → Preferences.

2. Vælg Sync.

3. Log ind eller opret en konto til 

EndNote Online.

4. Klik Enable Sync.



Grænseflade

• Venstre panel: My Library, Grupper.

• Midterpanel: Referenceliste.

• Højre panel: Summary, Edit, PDF.



Import af referencer

Import fra databasesider

1. Gå til en database (fx fra 

Embase).

2. Find en eller flere artikler.

3. Vælg Export → “RIS”, 

“EndNote”, “Citation 

Manager” eller lign.

4. Download filen.

5. Dobbeltklik på filen → den 

åbner automatisk i EndNote.



Import af referencer
Import af mappe med PDF’er

1. Gå til File → Import → Folder.

2. Vælg mappe med PDF’er.

3. Sæt kryds i Include subfolders.

4. Vælg importoptionen PDF.



Import af referencer

Import fra PDF

1. Træk en PDF ind i 

referencelisten.

2. EndNote forsøger at hente 

metadata.

3. Hvis metadata er forkert → ret 

i Edit.



Organisering af referencer

Grupper

1. Højreklik på venstre panel → Create Group.

2. Navngiv gruppen.

3. Træk referencer ind i den.



Organisering af referencer
Find Duplicates

1. Gå til Library → Find Duplicates.

2. Gennemgå sammenligningsvinduet (Title/Year/DOI).

3. Vælg “Keep This Record” på den reference med bedst 

metadata.



Arbejde med PDF’er

1. Vælg en reference med PDF.

2. Klik på PDF-fanen i højre panel.

3. Brug:

o Highlighter

o Sticky notes

4. Annotationerne gemmes i biblioteket og syncer til Online.



Cite While You Write i Word

Indsæt citation

1. Åbn Word → tjek at fanen 

EndNote er synlig.

2. Skriv en sætning.

3. Klik Insert Citation → Find 

Citation.

4. Søg efter en forfatter, titel, 

keyword.

5. Vælg reference → Insert.

6. Word indsætter citation + 

opbygger litteraturliste 

nederst.



Cite While You Write i Word

Hvis ikke EndNote fanen er synlig i Word

1. Åbn Filer → Instillinger.

2. Åbn Tilføjelsesprogrammer.

3. Vælg Administrer → COM-

tilføjelsesprogrammer.

4. Find EndNote Cite While You Write på 

listen → hvis boksen ikker er markeret, så 

sæt et flueben og vælg OK. Hvis boksen er 

markeret så fjern fluebenet og vælg OK, 

og gentag processen.



Cite While You Write i Word

Rediger citationer

1. Klik på citationen → Edit & 

Manage Citation(s).

2. Tilføj:

o Page number

o Prefix (fx “se også”)

o Suffix (fx “kap. 4”)

3. Klik OK.



Cite While You Write i Word

Skift reference style

1. I Word, gå til Style i EndNote-fanen.

2. Vælg fx APA 7th, Vancouver, Harvard.

3. Word opdaterer ALT automatisk.

4. I EndNote → Edit → Output Styles → Open Style 

Manager.

5. Søg og aktiver ønskede styles.

6. Download ekstra styles fra EndNotes

hjemmeside, hvis nødvendigt.



Deling og samarbejde

Del grupper:

1. Højreklik på en gruppe → Share Group.

2. Indtast den e-mailadresse som du har registreret din online konto med. 

Ikke nødvendigvis AU-mail.

3. Vælg read/write permissions.

NB:

• Man kan ikke dele et helt bibliotek – kun grupper.



Deling og samarbejde

Log på EndNote Online:

1. Gå til EndNote.com/login/ og vælg EndNote Online 

Classic Login

2. Indtast den e-mailadresse som du har registreret din 

online konto med, eller vælg registrer dig som bruger.

https://endnote.com/login/


Deling og samarbejde

EndNote Online:

Du kan nu tilgå dine referencer online, synkroniserer dit 

bibliotek med desktop versionen, og dele grupper.
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